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Preface



	Since its inception, AutoCAD has enjoyed a large user base, which has made it the most popular CAD software in the world. AutoCAD is widespread due to its logic and simplicity, which makes it easy to learn. AutoCAD evolved through the years to become a comprehensive software application addressing all aspects of engineering drafting and designing.


	This book addresses all levels of AutoCAD 2D drafting, Essentials, Intermediate, and Advanced, which makes it ideal for novice users, and for those seeking to be professional power users ready for industry.


	This book is not a replacement of AutoCAD manuals, but is considered to be complementary source that includes hundreds of hands-on practices to strengthen the knowledge learned and solidify the techniques discussed.


	At the end of each chapter, the reader will find “Chapter Review Questions” which are the same sort of questions you may see in the Autodesk certification exam; so, the reader is invited to solve them all. Correct answers are at the end of each chapter.


	Chapter 10 contains three projects: one is an architectural plan, presented in metric and imperial units. The other two projects are for mechanical engineering. One of them is thoroughly explained and the other is not! These two projects are also presented in both metric and imperial units.






About the Companion Files



Included with the book is a disc which contains the following (all of the companion files are also available for downloading from the publisher by writing to info@merclearning.com):


	A link to retrieve the AutoCAD 2024 trial version, which will last for 30 days starting from the day of installation. This version will help you solve all practices and projects (if you are a college/university student, you can download a student version of the software from www.autodesk.com)


	Practice files which will be your starting point to solve all practices in the book


	Copy the folder named “Practices” into one of the hard drives of your computer


	As for projects, you will find two folders inside, “Metric” for metric units projects, and “Imperial” for projects using imperial units






About the Book



This is the most comprehensive book about AutoCAD 2024 – 2D drafting on the market. It is divided into three major parts:

	Essentials: from Chapter 1 to Chapter 10. It assumes that the reader has no previous experience in AutoCAD; hence it starts from scratch. Chapter 10 contains three projects – one architectural and two mechanical using both imperial and metric units.


	Intermediate: from Chapter 11 to Chapter 18. It contains a deeper discussion on a subject we touched on in the Essentials part, or a new advance feature.


	Advanced: from Chapter 19 to Chapter 26. It discusses the most advanced features of AutoCAD 2024.



If you do not have any prior experience in AutoCAD this book is a perfect start, and you can stop at the end of any part. But if you want to be a real power user of AutoCAD, you should go through all the 26 chapters, solving all projects and practices.

This book is also a good resource to prepare for the AutoCAD Certified Professional exam.

The chapters are divided as follows:

	Chapter (1) covers AutoCAD basics along with the interface


	Chapter (2) covers AutoCAD techniques to draw with accuracy


	Chapters (3 & 4) cover all modifying commands


	Chapter (5) covers the AutoCAD method of organizing the drawing using layers and inquiry commands


	Chapter (6) covers the methods of creating and editing blocks, and inserting and editing hatches


	Chapter (7) covers AutoCAD methods of writing text


	Chapter (8) covers how to create and edit dimensions in AutoCAD


	Chapter (9) covers how to plot your drawing


	Chapter (10) has three projects, one architectural and two mechanical, covering both metric and imperial units


	Chapter (11) covers the creation of more 2D objects


	Chapters (12 & 13) cover advanced practices and techniques


	Chapter (14) covers Block tools and Block Editing


	Chapter (15) covers the creation of Text Style and Table Styles along with Formulas in tables


	Chapter (16) covers the creation of Dimension Style & Multileader style plus adding multileaders


	Chapter (17) covers the creation of Plot styles, the meaning of Annotative, and DWF creation


	Chapter (18) covers how to create a template file and customize AutoCAD interface


	Chapter (19) covers Parametric Constraints


	Chapter (20) covers Dynamic Blocks


	Chapter (21) covers Block Attributes


	Chapter (22) covers External Reference


	Chapter (23) covers Sheets Sets


	Chapter (24) covers CAD Standards and advanced layer commands


	Chapter (25) covers Importing PDF files, Design Views, AutoCAD Web, and Mobile Apps


	Chapter (26) covers the Drawing compare function






CHAPTER 1

AutoCAD 2024 Basics



In This Chapter



	Starting AutoCAD


	Dealing with the AutoCAD interface


	AutoCAD defaults and drawing units


	Dealing with file-oriented commands


	Undo and Redo commands








1.1 STARTING AUTOCAD



AutoCAD was released in 1982 by Autodesk, Inc., which was a small company at that time. It was designed to be used for PCs only. Since then, AutoCAD has enjoyed the biggest user base in the world in the CAD business. Users can use AutoCAD for both 2D and 3D drafting and designing. AutoCAD can be used for architectural, structural, mechanical, electrical, environmental, and manufacturing drawings and for road and highway designs.

Though the focus these days is BIM (Building Information Modeling), AutoCAD is still the most profitable software for Autodesk, Inc. due to its ease of use and comprehensiveness, which address all user needs. Another version of AutoCAD, called AutoCAD LT, is used for 2D drafting only. 

To start AutoCAD 2024, double-click the shortcut on your desktop that was created in the installation process. AutoCAD will show the Welcome window, as shown in the following:

[image: image]

[image: image]

While in the welcome window, you will be able to:

	Open an existing file, Open a Sheet Set, Explore the sample files that come with the software


	Start a new drawing, or Download more templates accessible online


	See the recent files you opened (either as a list, or as icons)


	Check if AutoCAD has an Announcement for you regarding your software/hardware


	Send your feedback to Autodesk




Starting a new file or opening an existing file will show you the interface of AutoCAD 2024, as shown in the following::

[image: image]


[image: image]

1. Application Menu

2. Start tab

3. File tab

4. Ribbon

5. Current File Name

6. Info Center

7. Sign In

8. ViewCube

9. Navigation Bar

10. Cross Hairs

11. Workspace

12. Status Bar

13. Command Window

14. Layout tab

15. Model tab

16. UCS Icon

17. Graphical Area



1.2 AUTOCAD 2024 INTERFACE



The AutoCAD interface is based on Ribbons and Application Menu. The most important feature of this interface is that the size of the Graphical Area will be larger.


1.2.1 Application Menu

The Application menu contains file-related commands:

[image: image]

Included are commands such as creating a new file, opening an existing file, saving the current file, saving the current file under a new name and in a different folder, import from different file formats, exporting the current file to a different file format, printing and publishing the current file, etc. We will discuss almost all of these commands in different places in this book. By default, you will see the recent files. You can choose how to display the recent files in the Application Menu using this control:

[image: image]

Also, you can choose how to sort the recent files using this control:

[image: image]


1.2.2 Quick Access Toolbar

This toolbar contains all File commands mentioned in the Application Menu along with Workspace and Undo/Redo.

[image: image]

The user can customize this toolbar by clicking the arrow at the end, which will produce the following:

[image: image]

As you can see, the user can add or remove commands; clicking Show Menu Bar may also be useful because the ribbon does not include all AutoCAD commands.

Share Drawing

This command will share a link of the current version of the drawing including its external references in AutoCAD Web, you will see the following message:

[image: image]

You can create a link which people can view it only, or, with the ability to edit and save copy of it. 



1.2.3 Ribbons

Ribbons consist of two parts: tabs and panels, as shown below:

[image: image]

Some panels have more buttons than shown: the following is the Modify panel:

[image: image]

Click the small triangle near the title and you will receive the following:

[image: image]

If you move away from the panel, buttons will disappear. To make them visible always, click the push pin. The new view are as follows:

[image: image]

For some commands, there are many options. To make the user’s life easier, AutoCAD put all the options in the same button. Refer to the following illustration:

[image: image]

The ribbons have a very simple help feature. If you hover the mouse over a button, a small help screen appears:

[image: image]

If the user leaves the mouse over the button for a longer period of time, AutoCAD will show more detailed help:

[image: image]

Panels have two states— either docked or floating. By default, all panels are docked in their respective tab. Drag and drop the panel in the graphical area to make it floating. One important feature of making the panel floating is you will be able to see it while other tabs are active.

You can send the panel back to its respective tab by clicking the small button at the top right side:

[image: image]

While the panel is floating you can toggle the orientation:

[image: image]

It will either extend to the right:

[image: image]

Or down:

[image: image]

The button at the end of the tab names allows you to cycle through the different states of the ribbons. The main objective of this new feature is to give you yet more graphical area. Clicking the small button will produce the following:

[image: image]



1.2.4 InfoCenter

InfoCenter is the place to access help topics online and offline, along with other tools:

[image: image]

For instance, if you type a word or phrase in the field shown below, AutoCAD opens the Autodesk Exchange window and finds all the related topics online and offline. Online means all Autodesk websites along with some popular blogs.

Use Sign In to access Autodesk Account. 



1.2.5 Command Window

By default, the command window is floating, but you can dock it at the bottom or the top of the screen. Reading the command window all the time will save lots of wasted time trying to figure out what AutoCAD wants. AutoCAD will show two things at the command window: your commands and AutoCAD prompts asking you to perform a particular action (e.g., specify a point, input an angle, etc.). Refer to the following illustration: 

[image: image]



1.2.6 Graphical Area

The graphical area is your drafting area. This is where you will draw all your lines, arcs, and circles. It is a precise environment with an XYZ space for 3D and an XY plane for 2D. You can monitor coordinates in the left part of the status bar.



1.2.7 Status Bar

The status bar in AutoCAD contains coordinates along with some important functions; some of them are for precise drafting in 2D and some of them are for 3D.

[image: image]

The buttons you will see on the status bar are not necessarily all that are available. To customize this, click on the last button at the right (the one with three horizontal lines) and you will see the following list (showing some of the options):

[image: image]



1.2.8 Start Tab

When you click the Start tab at any moment, you will receive the welcome screen again. Hence you can start a new drawing, open an existing drawing, etc.

At the left of the Start tab, you will see three horizontal lines if you click it, you will see the following menu:

[image: image]

This menu will allow you to do the same file functions of the main menu




1.3 AUTOCAD DEFAULTS



Before using the AutoCAD environment, you should be aware of the following AutoCAD settings:

	AutoCAD saves points as Cartesian coordinates (X,Y) whether metric or imperial numbers were used. This is the first method of precise input in AutoCAD to type the coordinates using the keyboard




[image: image]

	To specify angles in AutoCAD, assume east (to your right) is your 0° and then go counterclockwise. (This is applicable only for the northern hemisphere; we will learn in Chapter 10 how we can change this setting for the southern hemisphere)




[image: image]

	The wheel in the mouse has four zooming functions: Zoom In (move wheel forward), Zoom Out (move wheel backward), Panning (press and hold the wheel), and Zooming Extents (double-click the wheel)


	Pressing [Enter] or [Spacebar] is equal in AutoCAD


	When pressing [Enter] without typing any command, AutoCAD will repeat the last command. If it is the first thing you do in the current session, it will start Help


	Pressing [Esc] will cancel the current command


	Pressing [F2] will show the Text Window—check the following:




[image: image]



1.4 WHAT IS MY DRAWING UNIT?



If you draw a 6-units line in AutoCAD, what does AutoCAD really mean by 6 units? Is it 6 m, 6 ft, or neither? AutoCAD deals with whatever units you choose; if you mean 6 m, so let it be! If you mean 6 ft, AutoCAD will go with this assumption as well. What is important is that you be consistent throughout your file. This is true for the Model Space, where you will do your drafting, but when it comes to printing, you have to recall your assumption and set your drawing scale accordingly. In Chapter 9, we will discuss printing. At the bottom left of the screen you can see the model tab and the layouts, as shown in the following:

[image: image]



1.5 CREATE A NEW AUTOCAD DRAWING



This command will create a new drawing based on a premade template. Use the Quick Access Toolbar and click the New button:

[image: image]

Or you can click the (+) sign in the File tab:

[image: image]

You will see the following dialog box:

[image: image]

Do the following steps:

	Select the desired template file (AutoCAD template files have the extension *.dwt). AutoCAD 2024 comes with lots of premade templates that you can use (it is preferable for the companies to create their own template files). 


	Once you are done, click the Open button


	AutoCAD drawing files have a file extension of *.dwg


	AutoCAD will start with a new file (which has a temporary name like Drawing1.dwg; you should rename it to something meaningful)



NOTE

In the Start tab under New drop-down, you can do the same, as shown below:

[image: image]





1.6 OPEN AN EXISTING AUTOCAD DRAWING



This command will open an existing drawing file for additional modifications. From the Quick Access Toolbar, click the Open button: 

[image: image]

You will see the following dialog box:

[image: image]

Complete the following steps:

	Specify your desired drive and folder


	You can open a single file by selecting its name from the list and clicking the Open button, or you can double-click on the file’s name. Or, you can open more than one file by selecting the first file name, holding the [Ctrl] key, clicking the other file names in the list (which is a common MS Windows skill), and then clicking the Open button






1.6.1 File Tab

Using the File tab beneath the ribbon, you will see a tab for each opened file, as in the following:

[image: image]

The color used is gray. The current file (tab) will appear in a lighter gray, and the other tabs will appear in a darker gray. If you hover over one of the tabs, two things will take place:

	The path of this file will appear


	The model space and the layouts of this file will appear beneath




See the following:

[image: image]

There will be a blue frame around the model space view. Moving your mouse to the right will show the layouts in the graphical area; if you find what you are looking for, click the layout view to move to it.

NOTE

	A star beside the name of the file in the file tab means this file was modified and you need to save changes


	Click (×) beside the name to close the file, hence closing the tab


	The user can customize the File tabs and the Layout tabs by switching them off; all you have to do is to go to the View tab and locate the Interface panel; the two buttons will be blue if the tabs are on, but if you want to turn them off, click once on each button:




[image: image]

	You can now drag a file tab off of the AutoCAD application window, making it a separate window. This is good for multi-display setup. At any moment, you can right-click the title bar of a floating drawing window you will see the following options:




[image: image]

	These options will help the user to Move the file back to File Tab, pin the floating window, Save and Save As the floating window, close it, and Copy File Path, and File Location








1.7 CLOSING DRAWING FILES



This command will close the current opened files or all opened files, depending on the command you choose. Use the Application Menu, move your mouse to the Close button, then select either Current Drawing to close the current file, or All Drawings to close all the opened files in single command:

[image: image]

If any of the open files were modified, AutoCAD will ask if you want to save or close without saving, as in the following dialog box:

[image: image]



1.8 UNDO AND REDO COMMANDS



Undo and Redo are to help you to correct mistakes. They can be used in the current session only.


1.8.1 Undo Command

This command will undo the effects of the last command. You can reach this command by going to the Quick Access toolbar and clicking the Undo button. If you want to undo several commands, click the small arrow at the right. You will see a list of the commands; select the group and undo them:

[image: image]

Also, you can type u at the command window (do not type undo, because it has a different meaning), or press Ctrl + Z at the keyboard.



1.8.2 Redo Command

This command will undo the undo command. You can reach this command by going to the Quick Access toolbar and clicking the Redo button. If you want to redo several commands, click the small arrow at the right. You will see a list of the commands; select the group and redo them:

[image: image]

Also, you can type redo at the command window or press Ctrl + Y.




PRACTICE 1-1 AUTOCAD BASICS



	Start AutoCAD 2024


	Open the following files:

a. Ground Floor

b. Mechanical-1

c. Mechanical-2


	Using the File tab, check the three files and their layouts


	Use the different zoom techniques with the mouse wheel


	Using the Application menu, close all files without saving






NOTES

















CHAPTER REVIEW



	The File tab will show the Model space and layouts of the opened files

a. True

b. False


	The AutoCAD template file extension is _________

a. *.dwt

b. *.dwg

c. *.tmp

d. *.temp


	AutoCAD units can be a meter or foot, per user desire

a. True

b. False


	Moving the wheel forward will mean _________


	To undo any command in AutoCAD you can:

a. Click the Undo icon from the Quick Access Toolbar

b. Type u at the command window

c. 	Type [Ctrl] + Z

d. All of the above


	Ribbons consist of _________ and _________


	The Menu bar by default is not shown, but you can show it if you want to:

a. True

b. False


	The AutoCAD drawing file extension is _________


	Positive angles in AutoCAD are created by moving in this direction: _________






CHAPTER REVIEW ANSWERS



1. a

3. a

5.	d

7. a

9. CCW (counterclockwise)







CHAPTER 2

Precise Drafting in
AutoCAD 2024



In This Chapter




	What are the drafting priorities?


	How to draw lines, circles, and arcs using precise methods


	How to draw polylines using precise methods


	How to convert lines and arcs to polylines and vice versa


	What are Object Snap and Object Track?








2.1 DRAFTING PRIORITIES



While you are drafting, there are two main concerns in your mind: the accuracy of your drawing and how fast you can finish it. People crave to finish their drawings fast but without weakening the drawing’s accuracy. Experts tend to put accuracy ahead of fast production.

Accuracy is important in the context of the “life cycle” of the drawing. If your drawing is accurate, all the other people who will modify it in the future will be able to do their mission without hassle. On the other hand, their lives will be miserable if you finished your drawing fast, but none of the objects are accurate.

In this chapter, you will learn how to use the four most important drafting commands, which are:

	Line command, to draw line segments


	Arc command, to draw circular arcs


	Circle command, to draw circles


	Polyline command, to draw lines and arcs jointly




While we are discussing the four drafting commands, we will introduce accuracy tools, which will help you speed up the drafting process.



2.2 DRAWING LINES USING LINE COMMAND



This command will enable you to draw straight lines; each line segment presents a single object. To issue this command go to the Home tab, locate the Draw panel, and then select the Line button:

[image: image]

You will see the following AutoCAD prompts:



Specify first point:

Specify next point or [eXit/Undo]:

Specify next point or [Close/eXit/Undo]:

Specify next point or [Close/eXit/Undo]:




Using the first prompt, specify the coordinates of your first point. Keep specifying points, and when you are done, do one of the following:

	If you want to stop without closing the shape, use either X to exit the command, or press [Enter] ([Esc] will do the job as well, but do not make it a habit, as [Esc] generally means abort)


	If you want to close the shape and finish the command, press C on the keyboard or right-click and select the Close option


	If you made any mistakes, you can undo the last point by typing U on the keyboard or right-clicking and selecting the Undo option




This is what the right-click menu looks like:

[image: image]



2.3 WHAT IS DYNAMIC INPUT IN AUTOCAD?



Dynamic Input has multiple functions:

	It will show prompts at the command window in the graphical area


	It will show the lengths and angles of the lines before drafting, which will specify them accurately




In order to turn on/off the Dynamic Input, click the following button on the Status bar:

[image: image]


2.3.1 Example for Showing Prompts

By default, if you type any command using the command window, AutoCAD will help you by showing all the commands starting with the same letters, as in the following example:

[image: image]

We typed the letter m, and accordingly AutoCAD gave us all the commands starting with this letter. While Dynamic Input is on, this is applicable to the crosshairs as well, as in the following:

[image: image]

Let’s assume we started the command window, using either way. Once you press [Enter], the following prompt will appear:

[image: image]

Type in the x and y coordinates, using the [Tab] key to move between the two fields:

[image: image]



2.3.2 Example for Specifying Lengths and Angles

Once you specify the starting point, AutoCAD will use Dynamic Input to show the length and the angle of the line using rubber band mode:

[image: image]

NOTE

Angles are measured CCW starting from the east, but only for 180°, unlike the angle system in AutoCAD, which will be for the whole 360°.



Type the length of the line, then press [Tab] to input the angle (it will give 1° increments); once you are done, press [Enter] to specify the first line. Continue doing the same for the other segments:

[image: image]




PRACTICE 2-1 DRAWING LINES USING DYNAMIC INPUT



	Start AutoCAD 2024


	Open file Practice 2-1.dwg


	Using status bar, click off, Polar Tracking, Ortho, and Object Snap, and make sure Dynamic Input is on


	Draw the following shape, using 0,0 as your start point, bearing in mind all sides = 4, and all angles are multiples of 45°:

[image: image]


	Save the file and close it






2.4 EXACT ANGLES (ORTHO VS. POLAR TRACKING)



When using Dynamic Input angles are incremented by 1°, but still the user cannot depend on it to specify angles precisely in AutoCAD.

The Ortho function will force the lines to be at right angles (orthogonal) using the following angles: 0, 90, 180, and 270.

In order to turn on/off the Ortho, use the following button in the status bar:

[image: image]

However, what if we want to use other angles such as 30, 45, 60, etc.? Ortho will not help in this case; for this reason, AutoCAD introduced another function called Polar Tracking, which will show in the graphical area rays starting from the current point heading toward angles like 30, 45, etc. Since Ortho and Polar Tracking contradict each other, when you switch one on, the other will be turned off automatically. In order to turn on/off Polar Tracking, use the following button in the status bar: 

[image: image]

If you click the small triangle at the right of the button, you will see the following menu:

[image: image]

You can select the desired angle or select Tracking Settings to change some of the default settings of Polar Tracking. You will see the following dialog box:

[image: image]



2.4.1 Increment Angle

Increment Angle is the angle to be used along with its multiples. Select one from the list or type your own.



2.4.2 Additional Angles

If you are using 30 as your increment angle, then 45 will not be among the angles that Polar Tracking will allow you to use. Hence, you will need to specify it as an additional angle. However, be aware you will not use its multiples. 



2.4.3 Polar Angle Measurement

When you are using Polar Tracking, you have the ability to specify angles as an absolute angle (based on 0° at the east) or use the last line segment to be your 0 angle. Refer to the following illustration:

[image: image]

   
NOTE

While you control the angle using either Ortho or Polar Tracking, you can type in the distance desired and then press [Enter] to draw accurate distances. This method is called Direct Distance Entry.






PRACTICE 2-2 EXACT ANGLES



	Start AutoCAD 2024


	Open Practice 2-2.dwg


	Draw the following shape using Line command, starting from 0,0 as your starting point (or any point you like), bearing in mind you have to use Polar Tracking. All angles are 30 and its multiplications and all lines are 2 units in length, using the Direct Distance Entry method to input the exact distances:

[image: image]


	Save and close the file






2.5 PRECISE DRAFTING USING OBJECT SNAP



Object Snap, or OSNAP, is the most important accuracy tool to be used in AutoCAD for 2D and 3D as well. It is a way to specify points on objects precisely using the AutoCAD database stored in the drawing file.

Some of the Object Snaps are:

	Endpoint: To catch the Endpoint of a line, or arc


	Midpoint: To catch the Midpoint of a line, or arc


	Intersection: To catch the Intersection of two objects (any two objects)


	Perpendicular: To catch the Perpendicular point on an object 


	Nearest: To catch a point on an object Nearest to your click point




We will discuss more object snaps when we discuss more drawing objects.

Here are graphical presentations of each one of these OSNAPs:

[image: image] [image: image]

[image: image] [image: image]

[image: image]




2.5.1 Activating Running OSNAPs

To activate running OSNAPs in the drawing, click on the Object Snap button in the status bar:

[image: image]

If you click the small triangle at the right of the button, you will see the following menu:

[image: image]

You can switch on the desired OSNAPs one by one. If you want to make a more convenient change, select the Object Snap Settings option, and the following dialog box will appear:

[image: image]

There are two buttons at the right: Select All, Clear All. We recommend using Clear All first and then selecting the desired OSNAPs. When done, click OK.



2.5.2 OSNAP Override

While the Object Snap button is on, several OSNAPs are working, and others are not! Assume you want to temporarily switch all of them off, use a single OSNAP, and then after finishing set everything back to normal. This called OSNAP Override.

There are two ways to activate an override:

	Using the keyboard, type the first three letters of the desired OSNAP


	Using the keyboard, hold the [Shift] key, and then right-click. You will see the following pop-up menu:




[image: image]




PRACTICE 2-3 OBJECT SNAP (OSNAP)



	Start AutoCAD 2024


	Open Practice 2-3.dwg


	Check the Object Snap at the status bar and make sure that Endpoint, Midpoint, Intersection, and Perpendicular are the only OSNAPs switched on


	Using Object Snap and Line command, draw lines in the drawing to create the following:

[image: image]


	Save and close the file






2.6 DRAWING CIRCLES USING CIRCLE COMMAND



This command will draw a circle using different methods based on the available data. If you know the coordinates of the center, there are two possible methods. If the user knows the coordinates of points at the diameter of the circle, there are another two methods. Finally, if there are drawn objects like lines, arcs, or other circles which can be used as tangents for the to-be-created circles, there are two more methods. The following are the six methods to draw a circle in AutoCAD:

[image: image]

[image: image]

[image: image]

To issue this command, go to the Home tab, locate the Draw panel, then select the arrow near the Circle button to see all the available methods:

[image: image]



2.7 DRAWING CIRCULAR ARCS USING ARC COMMAND



This command will draw an arc part of a circle. To make our lives easier, AutoCAD uses eight pieces of information related to a circular arc. These are: 

	The starting point of the arc


	Any point as a second point on the parameter of the arc


	The ending point of the arc


	The Direction of the arc, which is the tangent that passes through the Start point. User should input the angle of the tangent


	The distance between the starting point and the ending point which is called Length of Chord


	The Center point of the arc


	The Radius


	The angle between Start-Center-End which is called Included Angle




Refer to the following illustration:

[image: image]

If you provide three of these eight pieces of information, AutoCAD will be able to draw an arc, but not with any three. The combination of the information needed can be found in the Home tab, using the Draw panel, while clicking the arrow near the Arc button to see all the available methods:

[image: image]

As you can see, the Start point is always required information. Normally the user should think counterclockwise when specifying points, but if on the other hand you want to work clockwise, simply hold the [Ctrl] key and it will change. 



2.8 OBJECT SNAPS RELATED TO CIRCLES AND ARCS



Some of the Object Snaps related to circles and arcs are:

	Center: To catch the Center of an arc or circle


	Quadrant: To catch the Quadrant of an arc or circle


	Tangent: To catch the Tangent of an arc or circle




Here are graphical representations of each one of these OSNAPs:

[image: image]

[image: image]
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2.9 USING OBJECT SNAP TRACKING WITH OSNAP



Sometimes OSNAP alone is not enough to specify desired points, especially if we need complex points. To solve this problem in the past we used to draw dummy objects to help us specify complex points, like in the case when you want to specify the center of the circle at the center of a rectangle. We used to draw a line from the midpoints of the two vertical lines, and the same for the horizontal lines. However, since the introduction of Object Snap Tracking, or OTRACK, in AutoCAD 2000, the drawing of dummy objects diminished. OTRACK depends on active OSNAP modes, which means if you want to use the midpoint, OTRACK requires that you switch the midpoint on first. To activate OTRACK go to the status bar and click the Object Snap Tracking button on:

[image: image]

The procedure is very simple:

	Using OSNAP go to the desired point and stand still for a couple of seconds (do not click), then move to the right or left (also up and down depending on the next point), and you will see an infinite line extending in both directions (this line will be horizontal or vertical depending on your movement). 


	If you want to use a single point to specify your desired point, move to the needed direction, type in the desired distance, and press [Enter].


	If you need two points, go the next point, and stay for a couple of seconds, then make the movement toward the desired direction. Another infinite line will appear. Go to the intersection point of the two infinite lines, and that will be your point.




[image: image]

[image: image]

Polar command will have a major contribution here as well. Let’s go back to the same dialog box:

[image: image]

Under Object Snap Tracking Settings, there are two choices:

	Track orthogonally only (default option)


	Track using all polar tracking settings




This means you can use the current Polar angles (increment and additional angles) to specify points using OTRACK.

NOTE

To deactivate an OTRACK point, stay at the same point again for a couple of seconds, and it will be deactivated.





PRACTICE 2-4A DRAWING USING OSNAP AND OTRACK



	Start AutoCAD 2024


	Open Practice 2-4a.dwg


	Using the proper OSNAP and OTRACK settings, create the four arcs as shown below:

[image: image]


	Create the two circles as shown below (Radius = 1)

[image: image]


	Using OSNAP and OTRACK (using two points), draw the circle at the center of the shape (Radius = 3.0)<Figure>

[image: image]


	Using OSNAP and OTRACK (one point) draw the two circles at the right and left (distance center-to-center = 5.0, and Radius = 0.5)

[image: image]


	Change the increment angle in the Polar Tracking dialog box to 45. Make sure that Track using all polar angle settings is on, draw a circle (Radius = 0.5), its center specified using OSNAP, OTRACK, and polar tracking as shown below:

[image: image]


	Do the same procedure to draw a circle at the top, to end up with the final shape as follows:

[image: image]


	Save and close the file






PRACTICE 2-4B DRAWING USING OSNAP AND OTRACK



	Start AutoCAD 2024


	Open Practice 2-4b.dwg


	Using the proper OSNAP and OTRACK settings, add lines and circles to make the shape look like the following:

[image: image]


	Save and close the file






2.10 DRAWING LINES AND ARCS USING POLYLINE COMMAND



Polyline command will do all or any of the following:

	Draw both line segments and arc segments


	Draw a single object in the same command rather than drawing segments of lines and arcs, like in Line and Arc commands


	Draw lines and arcs with starting and ending widths




To use the command, go to the Home tab, locate the Draw panel, then select the Polyline button:

[image: image]

The following prompt will appear:



Specify start point: 

Current line-width is 1.0000

Specify next point or [Arc/Halfwidth/Length/Undo/ Width]:




AutoCAD will ask you to specify the first point, and when you do, AutoCAD will report to you the current line-width; if you like it, continue specifying points using the same method we learned in the Line command. If not, change the width as a first step by typing the letter W, or right-clicking and selecting the Width option, which will bring up the following prompt:



Specify starting width <1.0000>:

Specify ending width <1.0000>:




Specify the starting width, press [Enter], and then specify the ending width. The next time you use the same file, AutoCAD will report these values for you when you issue the Polyline command. The process for Half-width is the same, but instead of specifying the full width, you specify half-width.

The Undo and Close options are identical to the ones at the Line command.

Length will specify the length of the line using the angle of the last segment.

Arc will draw an arc attached to the line segment; you will see the following prompt:



Specify endpoint of arc or [Angle/CEnter/CLose/ Direction/ Halfwidth/Line/Radius/Second pt/Undo/Width]:




The arc will be attached to the last segment of the line, or will be the first object in a Polyline command; using either method, the first point of the arc is already known, so we need two more pieces. AutoCAD will make an assumption (which you have the right to reject): AutoCAD will assume that the angle of the last line segment will be considered the direction (tangent) of the arc. If you accept this assumption, you should specify the endpoint. If not, choose from the following to specify the second piece of information:

	The Angle of the arc


	The Center point of the arc


	Another Direction to the arc 


	The Radius of the arc


	The Second point which can be any point on the parameter of the arc




Based on the information selected as the second point, AutoCAD will ask you to supply the third piece of information, but by all means it will not be out of the eight we discussed before.

NOTE

Normally the user should think counterclockwise when specifying points; on the other hand, if you want to work clockwise, simply hold the [Ctrl] key and it will change.





2.11 CONVERTING POLYLINES TO LINES AND ARCS AND VICE-VERSA



This is an essential technique which will convert any polyline to lines and arcs, and convert lines and arcs to polylines.



2.11.1 Converting Polylines to Lines and Arcs

The Explode command, will explode a polyline to lines and arcs. To issue this command, go to the Home tab, locate the Modify panel, then select the Explode button:

[image: image]

AutoCAD will show the following prompt:



Select objects:




Select the desired polylines and press [Enter] when done. Check the new shape; you will discover it has been changed to lines and arcs.



2.11.2 Joining Lines and Arcs to Form a Polyline

What we will discuss here is an option called Join, within a command called Edit Polyline. To issue this command, go to the Home tab, locate the Modify panel, then select the Edit Polyline button:

[image: image]

You will see the following prompts:



Select polyline or [Multiple]:

Object selected is not a polyline

Do you want to turn it into one? <Y>

Enter an option [Close/Join/Width/Edit vertex/Fit/ Spline/Decurve/Ltype gen/Reverse/Undo]: J




Start first by selecting one of the lines or arcs you want to convert. AutoCAD will respond by telling you that the selected object is not a polyline, giving you the option to convert this specific line or arc to a polyline. If you accept this, options will appear, and one of these options is Join. Select the Join option, then select the rest of the lines and arcs. At the end press [Enter] twice. Check the objects after finishing; you will find that they were converted to polylines.




PRACTICE 2-5 DRAWING POLYLINES AND CONVERTING



	Start AutoCAD 2024


	Open Practice 2-5.dwg


	Draw the following polyline using a start point of 18,5, and width = 0.1

[image: image]


	Then explode the polyline. The width will disappear


	Check the objects after exploding; they are now lines and arcs


	Save and close






2.12 USING SNAP AND GRID TO SPECIFY POINTS ACCURATELY



Snap and Grid will be the third method to help us specify points accurately in the XY plane.

By default, the mouse is not accurate, so we cannot depend on it to specify points. We need to control its movement, which is the sole function of Snap. Snap can control the mouse to jump in the X and Y plane with exact distances.

The grid by itself is not an accurate tool, but it will complement the Snap function. It will show horizontal and vertical lines replicating the drawing sheets. In order to turn Snap on/off, use the following button in the status bar:

[image: image]

In order to turn the Grid on/off, use the following button in the status bar:

[image: image]

Most likely, switching both on will not help; you will need to modify the settings to set your own requirements. Using the small triangle at the right of the Snap button, you will see the following:

[image: image]

Select the Snap Settings option; the Drafting Settings dialog box will pop up::

[image: image]

Input the Snap X Spacing and Snap Y Spacing (by default they are equal). Switch off the checkbox to make them unequal. Do the same for the Grid Spacing in X and Y. If you want the Grid to follow Snap, set the Grid spacing to zeros. In the Grid there are major and minor lines; set the major line frequency.

Set if you want to see the Grid in dots (as it was before AutoCAD 2011) and where (2D Model space, Block editor, or Sheet layout).

Grid behavior is for 3D only.

Specify the type of Snap: Grid Snap or Polar Snap.

The user can use function keys to turn on/off both Snap and Grid:

	F9 = Snap on/off


	F7 = Grid on/off






2.13 USING POLAR SNAP



While using the Snap command, the mouse will use the increment distance to specify the exact distance only in horizontal and vertical directions. While going diagonally, Snap will not help you. To solve this problem AutoCAD provided the concept of Polar Snap, which will specify exact increments using all the angles specified in the Polar Tracking dialog box. To activate the Polar Snap, AutoCAD will switch off the normal Snap (which is called Grid Snap). To do that go to the Snap button, click the triangle at the right of the button, and select the Snap Settings option, which will bring up the following dialog box:

[image: image]

Select the Polar Snap button, then specify the Polar distance as shown in the above illustration. 



PRACTICE 2-6 SNAP AND GRID



	Start AutoCAD 2024


	Open Practice 2-6.dwg


	Change Polar Tracking to use angle = 45


	Change the Snap to Polar Snap and set the distance to 0.5


	Draw the following shape, bearing in mind to start from point 22,5, make all segment lengths 6.5, and use an angle of 45:

[image: image]
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